
Changing the Look of
Values

The topics covered in this hour include the following:

• What formats are available

• How to choose a number style

• How to work with decimal places

• How to design custom numeric formats

• How to format conditionally

• How to hide zeros

• How to work with dates

During this hour you get all the information you need on how to format num-
bers—from finding out what number formats are available in Excel to choos-
ing number styles, working with decimal places, designing your own number
formats, using conditional formatting, hiding zeros, and working with dates.

At the end of this hour, you’ll be a pro at formatting numbers with Excel’s
formatting tools, making your numbers clearer to read and understand.
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What Formats Are Available?
Numeric values are usually more than just numbers. They often represent dollar values,
dates, percentages, or some other value. You can select the 
format type that appears as a real value in the Format Cells dialog box. To narrow the list
of formats, first select a category in the Category list, then specify the number of decimal
places. The default number of decimal places is two.

Excel lets you display numeric values in many ways. Formatting a number means chang-
ing the way it is displayed. You can format the number 500 to look like currency, in
which case it’s displayed as $500.00. You can even specify as many decimal places as
you want to display.

You can choose from four currency styles:

• Currency with negative numbers preceded by a minus sign

• Currency with red negative numbers

• Currency with negative numbers enclosed in parentheses

• Currency with red negative numbers enclosed in parentheses

Excel’s preformatted number formats are listed in Table 9.1.

TABLE 9.1 Excel Number Formats

Number Format Sample Number What It Does

General 4500 Default number format. Has no specific number format.
With General format, you can type a number with a deci-
mal point, dollar sign, comma, percent sign, date, time, or
fraction in a cell. Excel automatically displays the value
with the format you entered.

Number 4,500.50 Used for general display of numbers. The default Number
format is two decimal places and negative numbers are
black preceded by a minus sign. You can display the num-
ber of decimal places, whether you want a comma for a
thousand separator, and negative numbers in red or black,
preceded by a minus sign or enclosed in parentheses.

Currency $4,500.50 Used for general monetary values. The default Currency
format is two decimal places, with a dollar sign, and nega-
tive numbers are black preceded by a minus sign. You can
display the number of decimal places, whether you want a
dollar sign, and negative numbers in red or black, pre-
ceded by a minus sign or enclosed in parentheses.

162 Hour 9

12 0672325519 CH09  8/21/03  5:09 PM  Page 162



Accounting $4,500.00 Used for aligning dollar signs and decimal points in a col-
umn. The default Accounting format is two decimal places
and a dollar sign. You specify the number of decimal
places and whether you want a dollar sign.

Percentage 85.6% The default Percentage format is two decimal places and a
percent sign. Multiplies the value in a cell by 100 and dis-
plays the result with a percent sign.

Fraction 1/4 The default Fraction format is up to one digit on either
side of the slash. Used to display the number of digits you
want on either side of the slash and the fraction type such
as halves, quarters, eighths, and so on.

Scientific 4.50E+03 The default Scientific format is two decimal places. Used
to display numbers in scientific notation.

Text 278MC99 Used to display both text and numbers in a cell as text.
Excel displays the entry exactly as typed.

Choosing a Number Style
After you decide on a suitable number format, you can choose a number style using
either of two methods:

• Click the number style buttons on the Formatting toolbar.

• Choose Format, Cells and select a number style from the Format Cells dialog box.

Using the Toolbar to Change Number Formats
The Formatting toolbar offers several tools for changing number formats. Figure 9.1
shows the Formatting toolbar and the number style tools you use in this hour.
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TABLE 9.1 continued

Number Format Sample Number What It Does

Comma Style

Percent Style

Currency Style

FIGURE 9.1
Number style tools on
the Formatting toolbar.

The following To Do exercise shows you how to use the Formatting toolbar to change
number formats in the Sales workbook, Summary sheet. Your job is to format the num-
bers. If the workbook isn’t open now, open it before you start the exercise.
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To Do: Change Number Formats Using the Formatting Toolbar
1. Select the cells in which you want to display commas; in this case, select cells

B4:B8.

2. Click the Comma Style button on the Formatting toolbar. Excel applies the Comma
Style, displaying no commas, and two decimal places.

3. Select cell B9.

4. Click the Currency Style button on the Formatting toolbar. You should see the dol-
lar sign, a comma, and two decimal places in the selected cell.
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If any cells display number signs, you can widen the column to display the
numbers. Double-click the column border to the right of the column letter
for the column you want to adjust.

Using the Format Cells Dialog Box
Instead of using the number style tools on the Formatting toolbar, you can select a
value’s format type in the Format Cells dialog box. That way, you can get a number for-
mat to look exactly the way you want it.

The next To Do exercise steps you through changing the number format for a range of
cells using the Format Cells dialog box. You start by entering a column of numbers, so
that you can format them in the Sales workbook.

To Do: Use the Format Cells Dialog Box to Change Number
Formats

1. Click cell C6, type 275, and press Enter. In cell C7, type 195.50, and in cell C8,
type 1000.

2. Select the cells in which you want to display commas; in this case, select cells
C4:C8.

3. Click the Format menu and choose Cells. The Format Cells dialog box opens.
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To quickly display the Format Cells dialog box, press Ctrl+1.

4. Click the Number tab. On the left is a list of number format categories. On the top
right is a Sample box, where Excel shows you what a sample number would look,
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like formatted with that type. Also, you should see a description of the selected
number category at the bottom of the dialog box.

Changing the Look of Values 165

9

,
 

You can also change the number format of a cell by using the shortcut
menu; select the cell, click the right mouse button on the cell to display the
shortcut menu, and then choose Format Cells.

5. Click Number in the Category list. On the right, you see a number in the Sample
box, the Decimal Places box, the Use 1000 Separator (,) check box, and a list of
negative number formats. You need a 1000 separator, which is the comma.

6. Click the Use 1000 Separator (,) check box. A check mark appears in the box,
indicating you want to format your numbers with commas (see Figure 9.2).

Description of selected Number category

Negative numbers

Use 1000 separator (,)

Decimal places

Sample boxCategory list

FIGURE 9.2
Number format
options in the Format
Cells dialog box.

7. Click OK. You should see commas and two decimal places in the selected cells.

8. Select the cell in which you want to display a dollar sign; in this case, select cell C9.

9. Press Ctrl+1 to open the Format Cells dialog box.

10. On the Number tab, click Currency in the Category list. On the right, you see a
number in the Sample box, the Decimal Places box, a Symbol drop-down list, and
a list of negative number formats. The default Currency options is suited to what
you want.,
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11. Click OK. You should see dollar signs, commas, and two decimal places in the
selected cell. Click any cell to deselect the range.
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If you select zero decimal places, Excel rounds the value to fit this format.
For example, if you enter 5.5 in a cell, Excel rounds this number to 6 when
formatting to zero decimal places.

,
 

If you want to format a number with the Euro, choose Currency, click the
Symbol drop-down arrow, and select Euro (≠123) or Euro (123≠).

Working with Decimal Places
All of Excel’s number formats use either two or zero decimal places. The exception is
General format, which uses as many places as needed for a value. You can establish a
fixed number of decimal places or let Excel automatically round numbers for you. The
following sections examine both ways to work with decimal places.

Establishing a Fixed Number of Decimal Places
To establish a fixed number of decimal places, use a numeric format other than General
format. Two tools on the Formatting toolbar enable you to change the number of decimal
places for numbers. The tools are Increase Decimal (its icon contains .0 and .00 with a
left arrow) and Decrease Decimal (its icon contains .0 and .00 with a right arrow). Here’s
how these tools work:

• Click the Increase Decimal button each time you want to move the decimal point
one place to the left.

• Click the Decrease Decimal button each time you want to move the decimal point
one place to the right.

In the To Do exercise, you change the number of decimal places from two to zero for
numbers in the Sales workbook.

To Do: Specify Decimal Places
1. Select the cells in which you want to decrease decimal places for numbers with

commas; in this case, select cells B4:C8.

2. Click the Decrease Decimal button on the Formatting toolbar. Excel moves the
decimal point one place to the right. Notice that the number of decimal places for
numbers in the selected cells has changed from two to one.
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3. Click the Decrease Decimal button on the Formatting toolbar again and click any
cell to deselect the range. The number of decimal places for the numbers is now
zero, showing whole numbers.

4. Select cells B9:C9.

5. Click the Decrease Decimal button on the Formatting toolbar twice. Excel moves
the decimal point two places to the right. Notice that the number of decimal places
for numbers in the selected cells has changed from two to zero, displaying whole
numbers.

6. Click any cell to deselect the range.
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To repeat the number format change in another cell, select the Repeat
Format Cells option from the Edit menu or press the F4 (Repeat) key. By the
way, you can repeat any format command in another cell by using the F4 key.

Rounding Numbers
Excel can store up to 15 decimal places for a value. Many of Excel’s preformatted for-
mat settings round numbers to two decimal places. For instance, if you enter the value
$50.768 into a cell, Excel displays $50.77. Excel uses a dollar format to display the
value with two decimal places and a dollar sign.

Remember that the value in the cell has not been changed. The value is merely displayed
to look like it has been changed. The cell’s actual value is still 50.768, and any refer-
ences to this cell’s value receive the value 50.768. Therefore, formatted values are not
rounded at all; they only appear to be rounded.

To round numbers, use the Increase Decimal and Decrease Decimal tools on the
Formatting toolbar.

Designing Custom Numeric Formats
In addition to using Excel’s preformatted number format settings, you can create your
own formats. Here’s how it goes: Choose the Custom category on the Number tab in the
Format Cells dialog box. You’ll see format codes in the Type list on the right. Choose
one of the codes as a starting point for the custom format you want to design. Then make
your changes to the existing code you selected.
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The next To Do exercise gives you a chance to create a custom numeric format. Using
the Summary sheet in the Sales workbook, create a custom format that displays a dollar
sign followed by one space with commas and zero decimal places. 

To Do: Create Your Own Numeric Format
1. Select the cell that contains the number you want to format; in this case, select 

cell B9.

2. Choose Format, Cells. The Format Cells dialog box appears.

3. Click the Number tab.

4. In the Category list, click Custom.

5. In the Type list box, choose #,##0. The code displays in the Type text box. This
entry is a starting point for designing your custom format.

6. In the Type text box, click before the first #, and type $ followed by a space. Excel
shows you a formatted sample number in the Sample box, as shown in Figure 9.3.
This custom number format displays a dollar sign followed by a space with com-
mas and zero decimal places. This custom format is stored at the bottom of the
Type list.
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Custom category

#,##0 is the custom format type

$ #,##0 is the custom format

FIGURE 9.3
A custom format in the
Format Cells 
dialog box.

You can reuse all modified custom number formats within a worksheet with-
out retyping them. Excel stores all customized formats at the bottom of the
Type list. That way, you can select them over and over. However, if you cre-
ate a custom format for one workbook, you have to re-create the format for
other workbooks.
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7. Click OK. Excel applies the custom format to the number you selected.

8. Click any cell to deselect the range.

Formatting Conditionally
You probably are asking yourself, “What is formatting conditionally?” Formatting condi-
tionally lets you apply special formatting settings that take effect when the contents of a
cell meet specified conditions. For instance, if the values fall below a specific number,
you can show those values in bold pink, and if the values are greater than a specific num-
ber, you can display those values in bold blue. Excel’s Conditional Formatting command
helps you easily format your values based on specific conditions.

In the upcoming To Do exercise, you step through the process of setting up conditional
formatting for values on the Summary sheet in the Sales workbook.

To Do: Format Values Conditionally
1. Select the cells that contain the values you want to format conditionally; in this

case, select cells B4:B8.

2. Choose Format, Conditional Formatting. The Conditional Formatting dialog box
pops open, as shown in Figure 9.4. You should see boxes for setting up Condition 1
and the Format button for specifying the format for the values.
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Condition 1

Format

FIGURE 9.4
The Conditional
Formatting dialog box.

3. In the Condition 1 area, leave the Cell Value Is option. In the next box, choose
Less Than, and type 500 in the last box.

4. Click the Format button. The Format Cells dialog box appears.

5. In the Font Style list, choose Bold, and select the pink color patch in the Color
palette.

6. Click OK.,
 

12 0672325519 CH09  8/21/03  5:09 PM  Page 169



7. Click the Add button.

8. In the Condition 2 area, leave the Cell Value Is option. In the next box, choose
Greater Than, and type 500 in the last box. 

9. Click the Format button. The Format Cells dialog box appears.

10. In the Font Style list, choose Bold, and select the blue color patch in the Color
palette. 

11. Click OK to close the Format Cells dialog box. Click OK again to confirm your
conditional formatting choices. Click any cell outside of the selected range. Excel
displays numbers less than 500 in bold pink and numbers greater than 500 in bold
blue.

Hiding Zeros
Worksheets are often cluttered with zeros as a result of calculations or information that
hasn’t been entered. Formulas frequently display a zero when referenced cells are blank.
These zeros can make a worksheet confusing.

If you enter the sum formula in row 10 on the Detail sheet in the Sales workbook, the
formulas produce unwanted values of zero (see Figure 9.5). This worksheet shows sev-
eral columns where data has not been entered. Therefore, the cells with the formulas that
total the empty columns produce zeros. In this case, you might want to suppress the
zeros.

There are a couple of ways to hide zeros in a worksheet:

• Use the Tools, Options command to hide all values of zero in the worksheet. In the
Options dialog box, click the View tab (see Figure 9.6). In the Window Options
section, click the Zero Values check box to remove the check mark, which hides all
zeros on the worksheet.

• Create a custom number format in the Format Cells dialog box to hide zeros in a
range of cells.

The To Do exercise coming up walks you through hiding zeros in a range of cells on the
worksheet. Use the Summary Sheet of the Sales workbook to see how it works.
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FIGURE 9.6
Zero Values option 
in the Options 
dialog box.
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Unwanted zeros

FIGURE 9.5
Formulas that produce
unwanted values of
zero.

View tab

Zero values

To Do: Hide Zeros in a Range of Cells
1. Select the range that contains the zeros you want to hide; in this case, select cells

B10:D10.

2. Choose Format, Cells. The Format Cells dialog box appears.

3. Click the Number tab.
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4. In the Category list, click Custom.

5. In the Type text box, the General category appears, which is the type you want.
Click after the l in General and type a semicolon (;) followed by General and
another semicolon (;) See Figure 9.7.
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Custom category

Type is General;General

FIGURE 9.7
Format Cells dialog
box, hiding zeros.

6. Click OK.

7. Click any cell to deselect the range. The zeros are hidden in the selected range.

Working with Dates
Dates and times are actually numeric values that have been formatted to appear as dates
and time. You can change the way Excel displays the date and time if you want.

The Date and Time categories are in the Category list on the Number tab in the Format
Cells dialog box. You can use the Date format to display date and time serial numbers as
date values with slashes or hyphens. The default Date format is the month and day sepa-
rated by a slash; for example, 7/2. To display only the time portion, use the Time format.

The Time format lets you display date and time serial numbers as time values with hours,
minutes, seconds, AM, or PM. The default Time format is the hour and minutes sepa-
rated by a colon; for example, 11:00. You can perform calculations on the time values.
To display only the date portion, use the Date format.

Understanding Date and Time Formats
Excel offers a wide variety of date and time formats, which are listed in Table 9.2.
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TABLE 9.2 Excel’s Date and Time Formats

Date/Time Format Sample Date/Time

m/d 7/2

m/d/yy 7/2/98

mm/dd/yy 07/02/98

d-mmm 2-Jul

d-mmm-yy 2-Jul-98

dd-mmm-yy 02-Jul-98

mmm-yy Jul-98

mmmm-yy July-98

mmmm d,yyyy July 2, 1998

m/d/yy h:mm 7/2/98 7:30

m/d/yy hh:mm 7/2/98 19:30

hh:mm 13:35

h:mm AM/PM 1:35 PM

h:mm:ss AM/PM 1:35:50 AM

Changing Date Formats
After you figure out which date and time format you want to use, you can change the
dates using the Format Cells dialog box.

In the To Do exercise, you need to format the date on the Summary sheet in the Sales
workbook.

To Do: Change a Date Format
1. Click the Summary sheet tab. Select the cell that contains the date you want to for-

mat; in this case, select cell A12.

2. Click the Format menu and choose Cells. The Format Cells dialog box opens.

3. Click the Number tab.

4. Click the Date category in the Category list. On the right, you see a date in the
Sample box and a list of date types (see Figure 9.8).
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5. In the Type list, click the seventh date format (Mar-01) in the list. In the Sample
box, Excel shows you what a sample date would look like formatted with that type.

6. Click OK. You should see the formatted date in the selected cell.

Creating Custom Date Formats
If Excel doesn’t have a preformatted date format that suits your needs, you can create
your own date format. To do so, choose the Custom category on the Number tab in the
Format Cells dialog box. Excel displays format codes in the Type list on the right.
Choose one of the date format codes as a starting point for your custom date format.
Then make your changes to the format you selected.
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FIGURE 9.8
Date format options in
the Format Cells dia-
log box.
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You can reuse all modified custom date formats within a worksheet without
retyping them. Excel stores all customized date formats at the bottom of the
Type list. That way, you can select them again and again. However, if you
create a custom date format for one workbook, you have to re-create the
format for other workbooks.

Summary
Congratulations! You’ve done a nice job of working through all the formatting exercises
in this hour. Now that you have text formatting (refer to Hour 8, “Changing the
Appearance of Text”) and numeric formatting under your belt, you’re probably ready for
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adding pizzazz to your worksheets with borders, colors, and fills, which is explained in
the next hour.

Q&A
Q When I selected two decimal places, why did the numbers display with #

signs?

A If any cell displays number signs (#), you can widen the column to display the
numbers. Double-click the column border to the right of the column letter for the
column you want to adjust.

Q Does Excel have a fast way to display the Format Cells dialog box?

A Absolutely. Press Ctrl+1.

Q I like using a shortcut menu for making changes to my worksheet. Can I for-
mat numbers with a shortcut menu?

A Yes. You’re in luck! Select the cells you want to format and then click the right
mouse button in one of the selected cells. Your shortcut menu should appear. Then
choose Format Cells.

Q Does Excel have a shortcut for applying the same number format in various
places throughout a large worksheet?

A Certainly. You can repeat a number format change in another cell by selecting
Repeat Format Cells from the Edit menu or by pressing the F4 (Repeat) key. Either
way, you save time and keystrokes.

Q After I created a custom numeric format in one workbook, why couldn’t I use
it in another workbook?

A You can reuse all modified custom numeric formats within a worksheet without
retyping them. Excel stores all customized formats at the bottom of the Type list.
That way, you can select them over and over. However, if you create a custom for-
mat for one workbook, you have to re-create the format for other workbooks.
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